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Chapter 1 : GENERAL COMMENTS 概述 
1.1     INTRODUCTION说明 
MarsIn allows the input of any section along the ship length. The section is described by: 
•   Longitudinal elements contributing to the hull girder strength.纵向型材 
•   Transverse stiffeners.横向型材 
•   Compartments分舱 

1.2     MARSIN INTERFACE界面 
The module allowing to input the data of a section is organized around the following application: 

 
Figure 1: MARSIN 

Warning Box: displays warning message when MARSIN detects incoherence in the Section definition. 
Section view: displays a view of the section. 
1.3     A GOOD WAY TO MODELISE A SECTION剖面创建 
The geometry of a section is panel oriented: the section has to be divided into several panels, each 

one corresponding to a physical entity such as the outside shell, the strength deck, the inner bottom or a 
longitudinal bulkhead...分别创建几个剖面，每一个具有独立的实体（如外板、甲板、内底、纵向壁） 

Each panel is made of contiguous segments described by two nodes. Those segments have 
eventually different geometry (straight, circular or corrugated line).每个剖面板两个节点定义线段，这些线

段可以具有不同的几何特性（外板，圆或波形） 
The way of the description defines a direction on the panel. This direction is commonly used to define 

flange direction of longitudinals...还有方向定义（主要对于纵向折边） 
Each panel is an independent entity, even for calculation.每个剖面板可单独计算 
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Once the panels are fully described, welding joints and longitudinal stiffeners (with their scantling) can 
be located.一旦剖面板定义完成，可以进行焊接点和纵向型材的定义 

If necessary, it is also possible to define transverse stiffening zones.若需要还可进行横向型材的定义 
1.4     MAIN DIFFERENCES WITH MARSWIN特色 
1.4.1        Compartments data分舱数据（不同的剖面） 
A new data has been added: main destination of the compartment. This data leads to the evaluation 

of net scantling of the section.增加新的数据来说明分舱，已计算净构件规格 
The top of air pipe is replaced by the deck level to which the air pipe extends.可用透气管头代替甲板 
When openning an old MarsWin database, those data are initialized:当老的数据打开时，要初始定义

以下参数 
•   For the main destination: on the basis of the compartment load type. It should be checked carefully.

定义载荷类型 
•   For the air deck: minimum between the top of air pipe and the depth at strength deck.定义空气管高 
1.4.2        Span跨距 
The SpanS value is recovered through the Spacing of primary transverse structure (see 3.3 and 

3.8)." 主要横向构件跨距 
The SpanL value is recovered through the stiffeners span reduction.型材跨距 
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Chapter 2 : MAIN SECTION DATA 主要剖面数据 

On the Section menu, click on Main Data - Moments (Figure 46) to display the Main Section Data 
Window. 

2.1     MAIN DATA主要数据（第一个表） 
The first tab of the main section data window allows defining the X longitudinal location of the section 

and also to precise main data that might be dependent of this location. 
Moreover it allows defining the type of section (e.g. Half section, Full section, Thin walled structure). 

 
Figure 2: MAIN DATA WINDOW 

The Default (BSD) button of this window initializes the Main Data with the values already defined in 
the Basic Ship Data or with default values. It is only an initialization: a change in the Basic Ship Data 
doesn’t modify the Main Section Data按钮BSD数据见外板和基本船舶数据， 

It initializes:初步确定 
•   Identification = Midship section中剖面 
•   Longitudinal Location (from APP) = Scantling length / 2纵向位置（船长中点） 
•   Extension heights = 0.000 m延伸高度 
•   All the others data are initialized with their BSD equivalent.其他的数据见外板和基本船舶数据 
Extension heights (in m): used to define the zone in which the materials are defined. 
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Figure 3: EXTENSION HEIGHTS 

2.2     STRENGTH强度（第二个表） 
The second tab of the main section data window allows entering the design values of the still water 

bending moments at X, still water shear force and vertical wave bending moments. 沿纵向静水弯矩 
If you prefer don’t enter a SWBM（静水弯矩） value for a section, the calculations are based on: 

        如果没有输入静水弯矩值给剖面，会按以下计算 
•   The values defined in the BSD taken as midship section values and modified using the rule 

distribution law.按BSD基本船舶数据定义值并按相关规则修改 
•   If no value has been defined in the BSD, the rule distribution will be applied to the admissible rule 

values.如果没有BSD基本船舶数据定义值，则按规范分配的容许值。 

 
Figure 4: STRENGTH WINDOW 

The ship behavior defined in the BSD (both hogging/sagging, hogging only, sagging only) is 
displayed on screen. Obviously, it can not be corrected at this level. 

在 BSD 基本船舶数据定义的中拱/中垂，中拱，中垂，可能是不正确的。 
The rule calculations are based on rule values of vertical wave bending moments automatically 

calculated by the program.软件是自动按垂向波浪弯矩计算的。 
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However it is possible to perform special calculations with vertical wave bending moments defined by 
the user. If so, it is reminded that the obtained results are not according to the rules. 
        无论如何，可以由用户来定义。 

2.3     FATIGUE疲劳强度（第三个表） 
The third tab of the main section data window allows defining the data needed for fatigue calculation. 

 
This tab allows precising: 

Figure 5: FATIGUE DATA WINDOW 
•   Mean weld toe angle for butt joints ( 30° default value ) 
•   Mean weld toe angle for T joints and cruciform joints ( 45° default value ) 
On this tab (Figure 5), the Weld configuration button shows a window which allows to initialize the 

lambda (λ) value: 
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Figure 6: WELD CONFIGURATION WINDOW 

2.4     SHIP STATE船状态（第四个表） 
The fourth tab of the main section data window allows defining the Ship State. 

 
Figure 7: SHIP STATE WINDOW 

The State type can be: 
•   Project项目规划 
•   As Built在建 
•   Survey检验 
The state type survey allows performing a corroded section calculation.检验状态可计入腐蚀计算 
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The state index has no impact on the calculation. It is an help to manage a section for different 
surveys.状态不会影响计算 

2.5     HOLD DATA货舱数据（最后一个表） 
The last tab of the main section data window allows defining the hold data. These values have to be 

filled to calculate bulk pressure in case of hold having geometry shows in figure: 
        定义散货压力相关货舱的数据 

 
Figure 8: HOLD DATA WINDOW 
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Chapter 3 : SECTION GEOMETRY 剖面几何形状 

3.1     INPUT SEQUENCE ORGANIZED BY PANEL剖面数据输入顺序 
There are four main sequences to define the geometry of a section: 
•   Panels剖面板 
•   Nodes节点 
•   Strakes船底板 
•   Stiffeners型材 
These different sequences of the geometry description may be accessed by the following toolbar as 

follows: 

 
Figure 9: MARSIN TOOLBAR 

Panels: allows defining the panel name and characteristics.定义板架名 
Nodes: allows defining the geometry of the panel by a succession of segments.节点用于定义板架形 
Strakes: allows to locate welding joints and to enter the actual thickness of every strake on a panel. 

列板用于定义焊接相连的板组成板架 
Stiffeners: allows to locate all the longitudinals and to define their scantlings. 定义所有纵向型材 
Transverse stiffening: allows defining the areas transversally stiffened and the secondary transverse 

stiffeners定义所有横向型材 
Special Span: allows defining panel areas where a special span is to be considered 
不同剖面板架跨距 
All these input sequences are panel-oriented. It means that, inside an input sequence, the data are 

available panel by panel. When an input sequence is selected in the toolbar, the program displays 
generally the data corresponding to the current panel. The current panel is the last selected panel. 

They are five ways to move from one panel to another:有五种方法移动到不同剖面板架 
•   a direct click on the desired panel in the section view,直接选剖面名 
•   the Next Panel and Previous Panel items on the Tools menu (Figure 51),用工具选前后剖面 
•   the F5 key to jump to the previous panel,快捷键F5 
•   the F6 key to jump to the next panel, 快捷键F6 
•   using the panel list placed on the right-hand corner of MARSIN 列表中选取 

 
Figure 10: PANEL LIST 

3.2     CREATION AND DELETION OF DATA创建和删除数据 
In each input sequence, you can create or delete data: 
•   Nodes : creation or deletion of a segment 
•   Strakes : creation or deletion of a welding joint 
•   Stiffeners : creation or deletion of a group of stiffeners regularly spaced 
Each object has to be created or deleted using the following toolbar:工具 

 
Figure 11 : CREATION-DELETION TOOLBAR 

For example, if you want to create a new panel 
•   click on the panel button (Figure 9),the Panel management window (Figure 12) is displayed, 
•   click on the creation button (Figure 11). Inversely, if you want to delete an existing panel, 
•   click on the panel button (Figure 9), 
•   select the panel you want to delete, 
•   click on the deletion button (Figure 11). 
To create data, it is also possible to hit the F12 key instead of clicking the creation button. 
Another way to create or delete objects is to use Create object or Delete object on the Tools menu 

(Figure 51) 
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3.3     PANEL DATA剖面数据 

Clicking on the panel button  or on Panel on the Section menu (Figure 46), you enter the Panel 
management window: 

 
Figure 12: PANEL MANAGEMENT WINDOW 

In this window, you can create or delete panels using the creation or the deletion buttons (Figure 11). Each 
panel is defined by identification, a percentage of bending efficiency and spans. These values are assigned to 
every strake and every longitudinal stiffener of the panel.创建删除板架，每个板架定义名称，弯曲率和跨距。 

Panel Identification: up to 40 characters.剖面最多到40个 
The panel has to be clearly identified. This identification will appear in input sequences and in output of data 

and results. 
Bending Efficiency (in %): percentage of contribution to the overall longitudinal strength. 
DO NOT ENTER 50% FOR PLATINGS ON THE CENTER LINE中线上弯曲率不能用50% 
Spacing of primary transverse structure (in m): span of the strakes, in the ship longitudinal direction, 

between 2 consecutive transverse stiffeners.跨距：外板为两个横向型材之间的距离 
This value is used to calculate the rule thickness of the strakes longitudinally stiffened.跨距影响纵向列板厚 
Span L (in m): effective span of the longitudinal stiffeners on the panel.纵向跨距 
This value is only a reminder in case of old MarsWin database (see 1.4.2). Spacing and Span L can be 

locally changed (see 3.8.). 
It is also possible to assign particular values of bending efficiency to groups of stiffeners (see 3.6.2). Clicking 

on Tools button you can:可以复制板架，变换板架，复制和镜像 
•   Duplicate a panel. 
•   Transform a panel. 
•   Duplicate and mirror section. 
3.4     NODE BUTTON : GEOMETRY OF THE PANEL节点操作：剖面几何形状 
3.4.1        Nodes and segments节点和线段 
A panel is made of contiguous segments of different geometry (straight, circular or corrugated line). 

Each segment is described by:板架由线段定义几何形状（直线，圆弧，波形壁），而线段组成如下： 
•   Its ending node端部节点 
•   Its type of curve.曲线类型 
•   Its position code.位置点 
First node of a panel剖面的第一个节点 
When you define a panel, a first node (segment 0) is automatically created with coordinates by 

default: you have to correct these Y and Z coordinates. 

Clicking on the node button  or on Nodes - Plates on the Section menu (Figure 46), you enter the 
Node management window where these inputs are performed: 

弯曲系数 

外板跨距 

纵向型材跨距 

主要横向构件间距 

板架名称
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Figure 13: NODE MANAGEMENT 

 WINDOW Node creation窗口节点创建 

The creation button  allows you to create a segment extending the current panel. The deletion 

button  is used to delete nodes. 
It is also possible to insert a node between two existing nodes by clicking on the Tools… button 

(Figure 13) and selecting Insert node (Figure 21). See 3.4.5 for more information. 
Next segment - Previous segment: Those two buttons allow navigating segment by segment within a 

panel. A direct click on the desired segment in the section view is also possible. 
Node characteristics节点类型 
Coordinates of the node (in m): The Y and Z coordinates of the current segment ending node. 

Sometimes, it is not necessary (see 3.4.2.1, 3.4.4 and 3.4.5) to define them. 
Knuckle Code: It is used in the rule scantling calculation of strakes and stiffeners. The corresponding 

node is considered as a limit between two segments with a significant variation of curvature. A knuckle 
node affects the calculation of the spacing (E) between longitudinals or of the span of transverse plating. 

For instance, with this following detail: 

 
If the node 2 has the knuckle code, the spacing will be calculated with E1 or E2 
If the node 2 hasn’t the knuckle code, the spacing will be calculated with E1+E2 
Some facilities are provided to make easier the input of the coordinates: 
•   The bilge wizard (see 3.4.2.1). 
•   The tools button (see 3.4.5) to align or to insert nodes or to set the node position with the mouse. 
Segment characteristics线段类型 
The characteristics of the segment between the current node and the previous one consist in : 
Curve Type: it specifies the type of the segment. 

 : Straight line直线 

 : Tangent arc (see 3.4.2.2) 切线 

 : Arc (see 3.4.2.3)弧 

 : Corrugated segment (see 3.4.3)波形线 
Position Code: definition of the allocation of the segment inside the section. A position code in the list 

is to be selected. The possible positions are: 
       位置代码 
1 Undefined未定义 13 Inner hull内壳 
2 Keel plate平板龙骨 14 Double hull girder双壳桁材 
3 Bottom船底 15 Keelson or other girder底龙骨或其他桁材 
4 Bilge舭部 16 Tank and watertight bulkhead舱壁/水密舱壁 
5 Side shell舷侧 17 Vertical corrugation垂向波形壁 
6 Sheer strake舷顶 18 Wash bulkhead 
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7 Upper strength deck (weather)露天强力甲板 19 Cellular keel格型龙骨 
8 Upper strength deck (no weather)室内强力甲

 
20 Hopper well bulkhead泥驳舱壁 

9 Trunk deck凸起甲板 21 Solid bar keel实心龙骨 
10 Lower deck下甲板 22 Garboard plate舭龙骨 
11 Inner bottom内底 23 Margin plate边板 
12 Double bottom girder双底纵桁材 24 Miscellaneous其他 

The more precise position code has to be selected.尽量精确选择 
For the bottom plate at the centerline side, the position code Keel plate or Bottom can be equally chosen. 

3.4.2        Circles圆弧 
There is two ways to define circle: 
•   the Bilge Wizard 
•   the Curve Type buttons 

3.4.2.1              Bilge wizard舭部 
The bilge wizard is the best way to easily define circular plate tangent to the adjacent segments. 

Using this tool will create a straight segment, a circular segment and another straight segment. 
The bilge wizard has to be used very early into the process: click the bilge wizard immediately after 

the coordinate definition of the first tangent line-starting node. 
Example of input of bilge with a flat bottom输入示例具有平底舭部 
For a flat bottom, you enter: 

Node Y Coordinate Z Coordinate Click On 
1 0. 0.  

You should obtained this kind of section: 

 
and see the Round Shape Wizard displayed : 

 
Figure 14: ROUND SHAPE WIZARD 

End point coordinates (in m): coordinates of ending node of the 
second tangent line (node 4 on Figure 14). 

Tangent intersection (in m): coordinates of the intersection between 
the tangent lines. 

Circle radius (in m): Radius of the bilge 
Preview: Refresh the section view of the Round Shape Wizard 

without any effect on your section. 
Clicking on Ok will then create the bilge: 

 
Example of input of bilge with rise of keel输入示例具有斜升舭部 
For a rise of keel, you enter: 

Node Y Coordinate Z Coordinate Click On 



12 / 33 

1 0. 0. to create a node. 
2 2. 0.  

You should obtained this kind of section: 
 

and see the Round Shape Wizard displayed : 

 
Clicking on Ok will then create the bilge: 

 
3.4.2.2              Tangent arc与弧相切 
The Tangent Arc button is another way of defining circular segment tangent to both segments 

enclosing it. Therefore you have to create the nodes for the three segments (the circular one end its 
adjacent). 

Example of input of bilge with a flat bottom具有平底舭部输入 
For a rise of keel, you enter: 

Node Y Coordinate Z Coordinate Click On 
1 0. 0. to create a node. 
2 - - to create a node. 
3 - - to create a node. 
4 10. 10.  

You should obtained this kind of section: 

 
Click on segment 2 (node 3) and hit on the Arc Tangent 

button (Figure 13). The window here after is displayed on 
screen: 

R (in m): Radius of the circle Figure 15: TANGENT ARC DATA 
YTan and ZTan (in m): Y and Z coordinates of the tangent intersection of the enclosing segments. 
The coordinates of the first and the last nodes on this segment are automatically calculated and 

cannot be changed. The result is: 
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Example of input of bilge with rise of keel具有斜升舭部输入 
For example, for a rise of keel, you enter: 

Node Y Coordinate Z Coordinate Click On 
1 0. 0. to create a node. 
2 2. 0. to create a node. 
3 - - to create a node. 
4 - - to create a node. 
5 10. 10.  

You should obtained this kind of section: 

 
Click on segment 3 (node 4) and hit on the Arc Tangent button (Figure 13). The window here after is 

displayed on screen: 

 
The result is: 

 
3.4.2.3              Arc弧 
The Arc button can be used to define any circular segment. 
The coordinates of the first and the last nodes on this segment have to be input. 
The definition of an arc is completed by means of the window here after. It is displayed on screen, 

hitting arc button when the current node is the last node of the circle: 

 
R (in m) : Radius of the circle.Figure 16: ARC DATA 
With this method, you can define any kind of circular segment. For 

example: 
3.4.3        Corrugated segment波形 
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Choosing a corrugated segment makes this button appear:  
The definition of a corrugated segment is completed by means of the window hereafter obtained by 

clicking on the last button: 

 
Figure 17: CORRUGATED DATA 

h0 (in m): transverse width of the first corrugation. 
h1 (in m): height of corrugations. 
x0 (in m): distance from the first node of the corrugated segment (see here-above) to the first 

corrugation. 
x1 (in m): width of the flange. 
x2 (in m): projection of the inclined part on the support line (see here-above). 
N: number of straight parts of the corrugated segment: from the first node to the last node (including 

the first and the last straight part on the support line). 
A corrugated bulkhead is defined as a segment (with corrugations) located between two nodes. 
Those two nodes that start and end the “corrugated segment” define the support line of the 

corrugated bulkhead. 
This support straight line is the reference for all locations of welding joints, stiffeners, … This means 

that the curvilinear abscises must be projected on the support line. 
3.4.4        Intersection交点 
During the definition of a panel, you have to create nodes that are intersection nodes with a panel 

previously defined. To do that: 

•   Click on  as usual, 
•   select the type of intersection : 

 : Intersection with a panel defined by the Y coordinate  : Intersection with a panel defined by 

the Z coordinate  : Intersection with a node 
•   click on the relevant panel, 
•   enter the relevant coordinates. 
What is an intersection node?交点的解释（不同剖面的交点？） 
It is a node defined on a panel 2 and being located as intersecting with a panel 1. 
This node is not seeable in the list of nodes that define panel 1, but it may be used on panel 1 as an 

entry to locate stiffeners for example. 
3.4.4.1              Intersection with Y entered与Y向交点 
This method is to be used when the intersection node may be defined by: 
•   the selection of the intersection panel 
•   a Y coordinate. 
For example, this is the case of a horizontal segment: 

 
To define the node 6 as an intersection with the segment 1-2: 
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•   click on the intersection with Y entered button (Figure 13), 
•   the cursor change in :  and a message “Click on panel…” appears,要显示按钮 
•   click on the segment 1-2 to attach the node 6 with it. 

 
The following boxes are displayed: 

Figure 18: INTERSECTION Y ENTERED 
With Panel: panel on which the intersection is defined. 
Between nodes: nodes between which the intersection is defined. 
The Y coordinate of the intersection is available, but its Z coordinate is automatically calculated. 
3.4.4.2              Intersection with Z entered与Z向交点 

This method is to be used when the intersection node may be defined by: 
•   the selection of the intersection panel 
•   a Z coordinate. 
For example, this is the case of a vertical segment: 

 
To define the node 6 as an intersection with the segment 3-4: 
•   click on the intersection with Z entered button (Figure 13), 

•   the cursor change in :  and a message “Click on panel…” appears, 要显示按钮 
•   Click on the segment 3-4 to attach the node 6 with it. 

 
The followings boxes are displayed: 

 
Figure 19: INTERSECTION Z ENTERED 

With Panel: panel on which the intersection is defined. 
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Between nodes: nodes between which the intersection is defined. 
The Z coordinate of the intersection is available, but its Y coordinate is automatically calculated. 

3.4.4.3              Intersection with a node相交节点 
This method is to be used when the new node to define is an exiting node (generally on another 
panel). 

 
To put the node 6 of panel 2 in coincidence with the node 3 of panel 1: 
•   click on the intersection with node button (Figure 13), 

•   the cursor change in :  and a message “Click on node…” appears, 要显示按钮 
•   click on the Node 3 to attach the node 6 with it. 

 
The following box is displayed: 

 
Figure 20: INTERSECTION WITH NODE 

With Node: Node on which the intersection is defined. 
The intersection node coordinates are not available when the current segment is the one used to 

defined the intersection (segment 5-3 in the previous example). 
3.4.5        Insert node插入节点 
The creation button (Figure 11) permits to create nodes, but only at a panel end. With the Insert node 

tool, it is possible to create a new node on the segment you want. Using this tool changes the cursor in . 
A simple click on the segment on which you want to insert the node creates it. 

This tool is also reachable on the menu Tool (Figure 51). 
3.4.6        Tools工具 
There are some tools that make easier the input of nodes. They can be reached via the Other Tools 

button (Figure 13). This button display the following menu: 

 
Figure 21: OTHER TOOL MENU 

Those tools are just an help to define the node position: they don’t define properties for the nodes. For 
example, making a segment horizontal just set the position of the nodes, but the horizontality of the 
segment is not a recorded data. 
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3.4.6.1              Make horizontal水平 
The choice of the tool Make horizontal (Figure 21) will display the following sub-menu : 

 
•   with previous node make the Z coordinates of the current node equal to the previous node. For 

example, with the node 2 as current node : 

 
•   with next node make the Z coordinates of the current node equal to the next node. For example, with 

the node 2 as current node : 

 
3.4.6.2              Make vertical垂直 
The choice of the tool Make vertical (Figure 21) will display the following sub-menu: 

 
•   with previous node make the Y coordinates of the current node equal to the previous node. For 

example, with the node 2 as current node : 

 
•   with next node make the Z coordinates of the current node equal to the next node. For example, with 

the node 2 as current node : 

 
3.4.6.3              Align segment对齐 
The choice of the tool Align segment (Figure 21) will display the following sub-menu: 

 
•   Project node on segment places the current node at the nearest position on the line passing by the 

previous and the next nodes. For example, if the current node is the node 2 : 
 

 
•   Keep Z value, compute Y places the current node on the line passing by the previous and the next 

nodes keeping the old Z value. For example, if the current node is the node 2 : 
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•   Keep Y value, compute Z places the current node on the line passing by the previous and the next 

nodes keeping the old Y value. For example, if the current node is the node 2 : 

 
3.4.6.4              Set position with mouse用鼠标标确定位置 
The Set position with mouse tool (Figure 21) is another way to define the coordinates of a node. 

Choosing it change the cursor in . A simple click on the section view where you want to place the node 
position set it at this exact location. 

3.5     STRAKE列板 
All the strakes constituting the panel have to be defined by their width and their thickness.必须定义宽度

和厚度，其会自动编号 
They are automatically numbered, starting at number 1 on the first panel, and with an increasing 

numbering along the successive panels. 
Clicking on the Strake button (Figure 9) or on Strakes - Welding joints on the Section menu (Figure 46), 

you enter the Strake management window where these inputs are performed: 

 
Figure 22: STRAKE MANAGEMENT WINDOW 

During a first input, there is a strake automatically created on each panel with width equal to the width 
of the panel. 

The creation and the deletion buttons (Figure 11) allow you to create or delete strakes. 
Creating a strake means to divide the strake selected in the strake list (Figure 22) into two strakes of 

same characteristic, thickness and material, and with width equal to the half width. 
Strake List: display of the number and thickness of the strakes defined on the current panel. The strake 

selected is the current strake. 
To select a strake, click on a strake in the list or in the section view. 
Width (in m): width of the current strake. As general, this value is also the distance between 2 

consecutive welding joints. Nevertheless the first strake is the distance between the origin of the panel and 
the first welding joint. 

The software always recalculates the width of the last defined strake so that the ending joint of the 
strake coincides with the last node of the panel. 

Distance along: specifies how the widths are measured. There are 3 possibilities: 

•  : along the curve沿曲线 

•  : along the Y axis沿Y轴 
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•  : along the Z axis沿Z轴 
Thickness (in mm): thickness of the current strake. 
Material: material of the current strake. 
By default, the material defined in the main section data (see 2.1) is assigned to the strake. 
Hole Location (in m): distance from the beginning of the strake to the beginning of the hole 

(measured with respect of the Distance Type). 
Hole Breadth (in m): distance from the beginning to the end of the hole (measured with respect of the 

Distance Type). 
To perform an efficient entry of strakes: 

Press F12 to create a new strake, the current strake is divided into two, the first part is selected and 
the focus is on the width. 

Define the width and press Enter, the strake thickness is selected. 
Input the thickness and press Enter, the next strake is selected. 
Press F12 to create a new strake … 

3.6     STIFFENER型材 
3.6.1        Location位置 
This chapter concerns the description of longitudinal secondary stiffeners. For transverse stiffeners, 

refer to  3.7 part.纵向普通型材的设置，横向见3.7 
Clicking on the Stiffener button (Figure 9) or on Stiffeners on the Section menu (Figure 46), you enter 

the  Stiffener management window where these inputs are performed: 

 
Figure 23: STIFFENER MANAGEMENT WINDOW 

The longitudinal stiffeners have to be located on a panel. The successive locations of stiffeners must 
be given in an increasing order along the panel description. 

This location is done by defining groups of stiffeners having the same spacing. The creation and the 
deletion buttons (Figure 9) allow you to create or delete groups of stiffeners. 

It is necessary to define sequentially all the stiffener groups as they appear moving along the panel, 
without skipping any of them. 

Stiffener List: Display of the stiffeners defined on the current panel and of their scantling. They’re 
divided in groups of location which are numbered. 

The list shows: the group number, the stiffener number and its scantling. 
The stiffeners selected are the current stiffeners. They can belong to different groups. 
Next group - Previous group: Those two buttons allow navigating group by group within a panel. 
Selection of one stiffener选择单个型材 
Click the stiffener in the Stiffener List or in the section view. 
Selection of a group of stiffeners选择一组型材 
Click a stiffener of the previous (next) group and push the Next group (Previous group) button. 
Selection of stiffeners that are next to each other选择型材彼此相连 
Select the first stiffener you want to select; hold down the SHIFT key and click the last stiffener you 



20 / 33 

want to select. 
Select in the list the first stiffener you want to select, hold down the mouse button and drag the 

selection to the last stiffener you want. 
Selection of stiffeners that are not next to each other选择型材彼此不连 
Hold down the CTRL key, and then click each stiffener you want to select. 
Location Reference: It is either a node (select from node (Figure 23) and enter the node number), or 

the last stiffener of the previous group (select from previous stiffener (Figure 23)). 
Start (in m): Distance from the location reference (node or last stiffener of previous group) to the first 

stiffener of the group. 
Spacing (in m): spacing of the stiffeners for the group. 
Number: number of stiffeners in the group. 
A group of stiffener is a set of successive stiffeners having the same spacing, even if their scantlings 

differ. 
Along: the starting distance and the stiffener spacing can be measured along 

•  : the curve 

•  : the Y axis 

•  : the Z axis 
Direction: allows to precise if the stiffener webs are: 

•  : perpendicular to the curve 

•  : parallel to the Y axis 

•  : parallel to the Z axis 
Side: allows to precise, according to the panel direction, if the stiffeners are: 

•  : on the left side of the panel 

•  : on the right side of the panel 
Flange Direction: allows precising if the stiffener flanges are oriented: 

•  : in the description direction of the panel 

•  : in the opposite direction of the panel 
3.6.2        Scantling规格 
Scantling item规格 
Stiffener Type: allows selecting the stiffener type: 

•  : flat stiffener 

•  : bulb stiffener 

•  : angle stiffener 

•  : T-bar stiffener 
In case of flat or bulb type, flange characteristics aren’t available. 
If none type is chosen, the stiffener is considered as a NULL type, which is defined in 3.6.3. 
Web Height (in mm): Height of stiffener web (H1). 
Web Thickness (in mm): Thickness of stiffener web (E1). 
Flange Height (in mm): Width of stiffener flange (H2). 
Flange Thickness (in mm): Thickness of stiffener flange (E2). 

 
Figure 24: STIFFENER TYPE 

Special item特别部分 
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A click on it displays the following windows: 

 
Figure 25: SPECIAL ITEM 

Material: allows changing the current stiffener material, which, by default, is the supporting strake one. 
Efficiency (in %): allows changing the bending efficiency of current stiffeners. 
DO NOT ENTER 50% FOR STIFFENERS ON THE CENTERLINE 
DO NOT ENTER 50% FOR STIFFENERS LOCATED ON A PANEL ON THE CENTERLINE 
In that case, enter 100 %: the program detects their location and takes them into account only once 
Span reduction (in m): allows defining the span reduction of current stiffeners. 
 
Brackets item肘板 
A click on it displays the following windows: 

 
The brackets may be defined: 
•   No bracket ; 
•   At one end ; 
•   At both end. 

Figure 26: BRACKETS ITEM 
Length (in m): allows defining the bracket length. 
Type: (see 3.6.2. – Scantling item) 
 
3.6.3        Null type没有的类型 
A stiffener with NULL type has no effect on the geometric characteristics (areas, 

inertia, moduli) of the section. 
But it may be used in different ways with program convention as follows: 
•   Type NULL and a bending efficiency coefficient equal to 0 %. 
This type of stiffener allows defining an intermediate support for a transverse stiffener without 

affecting the span of the plating. It is a convenient way to enter a strut linking transverse frames in inner 
hull, for instance. 

Plating longitudinally stiffened: no action. 
Plating transversally stiffened: support of the transverse member only. 
•   Type NULL and a bending efficiency coefficient not 

equal to 0 %. 
This type of stiffener allows in the considered transverse 

section to reduce the plate extension without modification of 
the supporting conditions of the transverse members. 

Plating longitudinally stiffened: this stiffener reduces the 
spacing E used to calculate the scantlings of the plating and 
of the adjacent longitudinals. 

Plating transversally stiffened: this stiffener reduces the 
span used to calculate the scantlings of the plating. It is not 
considered as an intermediate support for the transverse 
stiffener. 

3.7     TRANSVERSE STIFFENING横向型材 
This sequence allows basically defining the areas 

transversally stiffened so that MARS is able to distinguish 
plating longitudinally stiffened from plating transversally 
stiffened. 

But the same sequence may be considered as defining 
the secondary transverse stiffeners whose scantlings may be 
evaluated in the calculation modulus. 
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The areas transversally stiffened have to be described by giving:横向型材必须给定： 
•   their location位置 
•   the corresponding spacing of secondary transverse stiffeners跨距 
•   the type of secondary transverse stiffener类型 
In a more precise definition, the areas transversally stiffened have to be located with respect of the 

starting and ending points of the transverse stiffeners.起点和终点 
The lengths of associated brackets may be defined for span correction as stated in the Rules. 
Every plating not considered in this sequence is supposed to be longitudinally stiffened. The locations 

are performed by giving: 
•   a START point (node or stiffener) and 
•   an END point (node or stiffener). 
The START point must be located before the END point in way of the panel description. 
Clicking on the Transverse Stiffening button (Figure 9) or on Transverse Stiffening on the Section 

menu (Figure46), you enter the Transverse Stiffening management window where these inputs are 
performed: 

Figure 27: TRANSVERSE STIFFENING MANAGEMENT WINDOW 
Location: enter either a node or a stiffener number in the corresponding input fields to define the start 

and end of stiffener. The stiffener numbers are always related to their location numbering on the panel. 
Spacing (in m): the transverse frame spacing to be considered for all members (stiffener or part of 

strake) 
located inside this transverse area. 
Side: allows precising, according to the panel direction, if the stiffeners are: 

•  : on the left side of the panel 

•  : on the right side of the panel 
Scantling item规格 
Type: allows selecting the stiffener type: 

•  : Primary supporting members.主要支撑构件 
• See 3.6.2 for the other scantling types. 
Material: allows defining the current stiffener material. 
Bracket at start item肘板开始端部描述 
A click on it displays the following windows: 

Figure 28: BRACKET AT START ITEM 
Length (in m): the bracket length are useful to get the rule scantling of the transverse stiffener. 
Type: (see 3.6.2. – Scantling item). 
Bracket at end item肘板结束端部描述 
A click on it displays the following windows: 

 
Figure 29: BRACKET AT END ITEM 

Length (in m): the bracket length are useful to get the rule scantling of the transverse stiffener. 
Type: (see 3.6.2. – Scantling item). 
3.8     SPECIAL SPAN特殊跨距 
The rule scantling of elements (strakes and longitudinal stiffeners) is based on a longitudinal span. 

The default values are those defined for the panel (in general panel description).纵向跨距值在总表中已定

义。也可以通过本表准确定义 
This input allows defining panel areas where a special span is to be considered (for strakes and/or 

longitudinals). 
Clicking on the Special Span button (Figure 9) or on Special Span Areas on the Section menu (Figure 

46), you enter the Special Span management window where these inputs are performed: 
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Figure 30: SPECIAL SPAN MANAGEMENT WINDOW 

Start: enter either a node or a stiffener number in the corresponding input field. 
End: enter either a node or a stiffener number in the corresponding input field. 
Local spacing of primary transverse structure (in m): special span value for primary transverse 

structure. 
Reduced span by subdivision of the plate (in m): special span value for strakes only. 
IF YOU WANT TO KEEP PANEL VALUES LEAVE BLANK THE TWO INPUT FIELDS. 
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Chapter 4 : COMPARTMENTS AND LOADS 分舱和载荷 

The compartments and loads descriptions are managed by the toolbar as follows : 

 
Figure 31 : COMPARTMENTS AND LOADS TOOLBAR 

4.1     COMPARTMENTS分舱 
Clicking on the compartment button (Figure 31) or on Compartments - Loading cases on the Section 

menu (Figure 46), you enter the Compartments management window: 

 
Figure 32 : COMPARTMENTS MANAGEMENT WINDOW 

In this window, you can create or delete compartments using the creation or the deletion buttons 
(Figure 11). Each compartment is defined by a name, a main destination, a type and a list of node. 

Name: used to identify the compartment.舱名 
Main destination: choose a compartment main destination in the list.用途 
The possible destinations are:下列用途 

1 Ballast压载 
2 Cargo oil / Fuel oil货油/燃油 
3 Other Liquid Cargo其他液体 
4 Dry bulk干散货 
5 Spoil破损 
6 Accomodation space居住 
7 Other destination其他 

Type: choose a compartment type in the list.The possible types are:类型 
1 Tank舱 
2 Double bottom, skin双底 
3 Dry compartment干舱 
4 Engine room机舱 
5 Boiler compartment锅炉间 
6 Tunnel隧 
7 Hopper well 1泥箱 
8 Hopper well 2泥箱 

Description by node circuit: enter the list of nodes of compartment contour.描述分舱节点围饶 
If the compartment is entirely located on one side of the section, the first and last nodes are to be the 

same.如果分舱仅放在剖面的一边，起始节点和最后的节点必须相同。 
You don’t have to enter all the nodes along the compartment contour. For instance:必须输入所有的节
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点轮廓围绕分舱 

  can be describe with: 1 4 5 1. The result is: 示例  
The list of nodes is also used in the calculation modulus to determine the highest point after rolling in 

tanks. The contour of an opened hold is generally not complete because the hatch cover has not to be 
defined in MARS. So the upper node on the vertical axis is missing. To obtain a correct calculation of the 
center of gravity, 

it is necessary to start the description of the 
contour by the low node located on the vertical axis: 
MARS will close the contour with an horizontal line at 
the level of the last defined node.软件将封闭最低点在垂

向轴上 
4.1.1        Dimensions尺寸 
Clicking on the Dimensions button (Figure 32), the 

compartment-dimension window is displayed: 
Figure 33: COMPARTMENT-DIMENSION WINDOW 
Length (in m): compartment length. 舱长Breadth (in m): 

compartment breadth.舱宽 Height (in m): compartment 
height.舱高 

X start (in m): longitudinal location of start compartment 
from APP.纵向起点距尾垂线的距离 

Xg (in m): longitudinal location of compartment center 
of gravity from APP. 纵向舱重心点距尾垂线的距离 

The following data may be obtained by calculation clicking on Always use compute values check or 
by direct input:也可以选择使用计算值或输入值 

Yg (in m): center of gravity (Centerline). 
Zg (in m): center of gravity above base line. 
Zmin/BL (in m): min of compartment from base line. 
Ztop/BL (in m): top of compartment from base line. 
If you don’t want use the Rule values for highest point / total acceleration click in the related check. 

The window become: 

 
Figure 34: COMPARTMENT-DIMENSION WINDOW (2) 

4.1.2        Loading cases载荷 
Clicking on the Loading Cases button (Figure 32), the compartment load window is displayed: 
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Type: select a load type.Figure 35: COMPARTMENT LOAD WINDOW 

Liquid cargo液货 
Load test height (in m): tank testing load height from base line. Air Pipe (in m): distance from top of 

air pipe height to base line. Density liquid: density of liquid cargo. 
Setting pressure (in bar): setting pressure of safety valves. 
Bulk cargo散货 
Load in hold (in t): load in hold (bulk or spoil). Density of bulk or spoil: density of bulk or spoil. Friction 

angle (in deg): internal friction angles for bulk. 
This input allows defining for the same compartment a liquid cargo and a bulk cargo. This facility may 

be used for ballastable hold in bulk carrier. 
4.1.3        Resonance共振 
Clicking on the Resonance button (Figure 32), the Resonance window is displayed. 
The user may ask to the program to calculate in any case the risk of resonance due to roll or sway 

checking the relative checkbox on the window. 
In Tank geometry frame the user may choose the case to calculate the coefficient for reference 

pressure for calculation of sloshing loads. 
The first tab of the Resonance window allows defining the values in inclined ship condition. 

 
Figure 36: RESONANCE - INCLINED SHIP CONDITION 

Effective breadth (in m): breadth of the free surface of the liquid, measured horizontally with the ship 
at rest and depending on the filling level dF for ships without watertight or wash longitudinal bulkheads; for 
ships fitted with watertight or wash longitudinal bulkheads the effective breadth is delimited by these 
bulkheads. 

The second tab of the Resonance window allows defining the values in upright ship condition. 
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Figure 37: RESONANCE - UPRIGHT SHIP CONDITION 

Effective length (in m): length of the free surface of the liquid, measured horizontally with the ship at 
rest and depending on the filling level dF. 

The last tab of the Resonance window allows to define the filling level and the corresponding free 
surface length and free surface breadth to evaluate the risk of resonance for each of these. 

 
Figure 38: RISK OF RESONANCE (2) 

These data are used to evaluate the risk of resonance of 
the compartment in roll, sway and pitch. This check is reachable 
through the prints (see 6.2.1). 

4.2     DECK LOAD甲板载荷 
The definition of deck load is panel oriented. It means that a 

deck load is defined between two nodes in a panel. Clicking on 
the Deck Load button (Figure 31) or on Deck Load on the 
Section menu (Figure 46), you enter the 

Deck Load management window: 
 

Figure 39: DECK LOAD MANAGEMENT WINDOW 
From Node: node number for the start of load extension. 
The starting point of the load extension must be located 

before ending point (in way of the panel description). 
To Node: node number for the end of load extension. 
Type: choose the load type in the list proposed. 
The possible types are:甲板负荷类型 



28 / 33 

1 Cargo Deck 
2 Accommodation deck : large public rooms 
3 Accommodation deck : large rooms with fixed furniture or cabins 
4 Accommodation deck : other spaces 
5 Wheel load 

Distributed load (in t/m²): in case of cargo deck only. In case of Wheel load type the window become: 

 
Figure 40: DECK LOAD MANAGEMENT WINDOW (2) 

Axle load (in t): load for considered axle. 
Number of wheels for the considered axle: wheel number. 
The definition of a wheel load data is completed by means the window here-after obtained by clicking 

on the 
Wheel load data… button: 

 
Figure 41 : WHEEL LOAD DATA WINDOW 

Wheel configuration: choose a configuration in the list. 
The possible configurations are: 

1 Single wheel configuration 
2 Double wheel configuration 
3 Triple wheel configuration 
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Chapter 5 : FATIGUE 疲劳 

Clicking on the Fatigue button  or on Fatigue on the Section menu (Figure 46), you enter the 
Fatigue management window: 

 
Figure 42: FATIGUE MANAGEMENT WINDOW 

Stiffeners list: allows selecting the stiffeners to be fatigued. Stiffeners type: displays the type of the 
selected stiffeners. The fatigue details can be selected by: 

• the details… button (Figure 42) which display a view of the connection type and of the collar plate 
with the relevant Kh and Kl coefficients ; 

 
Figure 43: FATIGUE DETAILS 

• the Connection type list (Figure 42) 
b (in mm): geometric characteristic of a stiffener for fatigue. 
Factor Km for misalignment: allows defining the stress concentration factor for misalignment. 
Clicking on Weld configuration button you can change for the stiffener selected the default value for λ 

coefficient defined in Main Section data (see 2.3. - fatigue tab). 
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Chapter 6 : GENERAL FEATURES 特色 

6.1     MENUS菜单 
File Menu文件 
It allows managing the sections (save, open), to print and to quit MARSIN. 

 
Figure 44: FILE MENU 

Item Use Shortcut 
New… Creates a new section.  
Open.. Opens an existing section. You can also press Ctrl + O. 
Save Saves the opened section. You can also press Ctrl + S or 
Save as… Saves a copy of the section with another name.  
Export drawing Creates a bitmap file from the section drawing.  
Print Data… Prints the data of the section (see 6.2.1). You can also press Ctrl + S or 
Print Drawing… Prints a drawing of a section (see 6.2.2).  
Quit Quits MARSIN to return to MARSHELL. You can also press Ctrl + Q or 

Edit Menu编辑 
It allows undoing the last action or copy the section drawing to clipboard. 

 
Figure 45: EDIT MENU 

Item Use Shortcut 
Undo Cancels the last action. Ctrl + Z 
Copy Section Drawing to clipboard Allows pasting the section drawing in any other application.  

Section menu剖面 
It gathers the entries to the input fields. 

Figure 46: SECTION MENU 
 

Item Use Shortcut 
Main data - Moments… Displays the Main Section Data Window (see Chapter 2 :).  
Panels Displays the Panels management window (see 3.3).  
Nodes - Plates Displays the Nodes management window (see 3.4).  
Strakes - Welding joints Displays the Strakes management window (see 3.5).  
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Stiffeners Displays the Stiffeners management window (see 3.6).  
Transverse Stiffening Displays the Transverse Stiffening management window (see 3.8).  
Special Span Areas Displays the Special Span management window (see 3.8).  
Compartments - Loading cases Displays the Compartments management window (see 4.1).  
Deck Load Displays the Deck Load management window (see 4.2).  
Fatigue Displays the Fatigue management window (see Chapter 5 :).  

Check menu检查 
It includes checking tools. 

 
Figure 47: CHECK MENU 

Item Use Shortcut 
Materials Displays the strakes and stiffeners with a different color for each material.  
Bending Efficiencies Displays the strakes and stiffeners with a different color for each bending 

efficiency. 
 

Span (see Figure 48)  
Thickness Displays the strakes with a different color for each thickness.  
Longitudinal stiffener (see Figure 49)  
Positions Codes Displays the segments with a different color for each position code.  
Transverse stiffener (see Figure 50)  
Panel List Displays a list of the current entry data. These lists are the exact reflect of 

what would be printed with the Print Data function (see 6.2.1). 
Ctrl + L 

 
Figure 48: SPAN SUB-MENU 

Item Use Shortcut 
Spacing of primary 
transverse structures 

Displays the strakes with a different color for each span.  

Effective Span Displays the strakes and stiffeners with a different color for each span.  

 
Figure 49: LONGITUDINAL STIFFENERS SUB-MENU 

Item Use Shortcut 
Stiffeners scantling Displays the stiffeners with a different color for each stiffener scantling.  
Bracket scantling Displays the brackets with a different color for each bracket scantling.  
Bracket length Displays the bracket length.  
Span reduction Displays the span reduction.  

 
Figure 50: TRANSVERSE STIFFENERS SUB-MENU 

Item Use Shortcut 
Stiffeners scantling Displays the transverse stiffening zones with a different color for 

each scantling of those transverse. 
 

Stiffeners spacing Displays the transverse stiffening zones with a different color for 
each spacing of those transverse. 

 

Tools menu:工具 
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Figure 51: TOOLS MENU 
Item Use Shortcut 
Add object Creates data (see 3.2). or F12 
Delete object Deletes data (see 3.2).  
Insert node… Inserts a node (see 3.4.5 ), this item is available only during the node input 

sequence. 
 

Zoom Allows zooming in (see 6.3).  
Previous panel Changes the current panel to the previous one (see 3.1). F5 
Next panel Changes the current panel to the next one (see 3.1). F6 

Options menu选项 

 
Figure 52: OPTIONS MENU 
Item Use Shortcut 
Colors… Displays a set up window for the colors on the screen or a printer.  
Preferences Displays a set up window for the drawing preferences on the screen or a printer.  
Refresh section Refreshes the screen in case of display anomalies. F9 

6.2     PRINTING打印 
6.2.1        Printing data打印数据 

Clicking on  or on Print Data… on the File menu (Figure 44) or pressing Ctrl + S, you enter the 
Print Data management window: 

 
Figure 53: PRINT DATA MANAGEMENT WINDOW 

This window allows you to select what you want to print. The All (None) button selects (deselects) all 
the items of the list. 

Front page produces the cover page of a report. 
6.2.2        Printing drawing打印图形 
Clicking on Print Drawing… on the File menu (Figure 44), you enter the Print Drawing management 

window: 
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Figure 54: PRINT DRAWING MANAGEMENT WINDOW 

This window allows you to select which item will be printed on the item. 
The Normalized scale check box will make the drawing printed with a regular scale (e.g. 1/50, 

1/100…). 
6.3     ZOOM窗口 
It is possible to Zoom in on or out of the Section view thanks to the Zoom Toolbar: 

 
Figure 55: ZOOM TOOLBAR 

A first click on the Zoom button (Figure 55) or on Zoom on the Tools menu (Figure 51) changes the 

cursor in  and allows you to zoom in the section view by simple click on it. 
A second click on the Zoom button (Figure 55) or on Zoom on the Tools menu (Figure 51) changes 

back the cursor in  and allows you to work on your zoomed section view. 
To zoom out of the section view, you can: 
•   Click on the No Zoom (1:1) button (Figure 55) to bring back the view to the initial size. 
•   Right-click on the section view when the Zoom button is down. 
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